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QUESTION NO: 1 
 
A TCP/IP network interface that is configured to use DHCP obtains which of the 
following information from the DHCP server? (Select THREE).  
 
A.  IP address 
B.  interface speed DC.  MAC address 
D.  whether the interface is full duplex or half duplex  
E.  subnet mask 
F.  default gateway address 
 
Answer:  A, E, F 
 
 
 
 
QUESTION NO: 2 
 
The limited range of an IEEE 802.11g network could be extended by adding which of the 
following devices to the network?  
 
A.  frame relay  
B.  bilinear amplifier  
C.  access point  
D.  Bluetooth relay 
 
Answer:  C 
 
 
 
QUESTION NO: 3 
 
Which of the following are SCSI types that allow for 16 devices, including the adapter, to 
be connected on a single shared cable? 
 
A.  Ultra Wide SCSI 
B.  Fast SCSI 
C.  Ultra SCSI 
D.  Fast Wide SCSI 
E.  Ultra 2 SCSI 
 
Answer:  A, D 
Explanation: Wide SCSI buses support 16 devices, rather than the 8 devices specified in 
regular SCSI. 
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Incorrect Answers: 
* Fast SCSI supports a maximum of eight devices. 
* Ultra SCSI is capable of supporting a maximum of eight devices. 
* Ultra 2 SCSI can only support 8 devices. 
 
Reference: 
James G. Jones and Craig Landes, A+ Exam Cram 2 (2nd Edition), QUE Publishing, 
Indianapolis, 2003, p. 326. 
 
QUESTION NO: 4 
 
A technician is assisting a user on the telephone and directs the user to a troubleshooting 
website. The user becomes angry and states that the user could have performed that 
action alone. Which of the following actions should the technician take? 
 
A.  Ask whether the user would like to call back when the user is calm.  
B.  Ask the user about the specific difficulties, listen and attempt to help the user.  
C.  Tell the user that the technician cannot help if the user is not willing to participate. 
D.  Tell the user that the technician will transfer the user to another technician. 
 
Answer:  B 
 
 
QUESTION NO: 5 
 
A technician discovers a half-empty bottle of acetone. Which of the following should the 
technician do to dispose of the acetone?  
 
A.  Fill the bottle with water, shake the bottle and pour the contents down a sink drain.  
B.  Put on Level-3 HAZMAT gloves and pour the remaining liquid down a floor drain.  
C.  Send the bottle and remaining contents to an appropriate recycling center. 
D.  Unscrew cap of bottle and let the acetone evaporate for 48 hours. 
 
Answer:  C 
 
 
QUESTION NO: 6 
 
Which of the following is the SCSI ID number generally recommended for the CD-
ROM? 
 
A.  IDO. 
B.  id 5. 
C.  ID 2.  
D.  ID 3. 
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Answer:  D 
Explanation: Every other device can be set to any number as long as it’s not in use. It is a 
recommended practice in IT community to set the SCSI ID number for CD-ROM drives 
to 3. 
 
Incorrect Answers: 
* Setting the bootable (or first) hard disk to ID 0 is the accepted IT community 
recommendation. 
* ID 3 would be the better choice to assign to the CD-ROM drive. 
* ID 2 is usually set aside for the Floppy drive. 
 
Reference: 
David Groth and Dan Newland, A+ Complete Study Guide (2nd Edition), Sybex, 
Alameda, CA, 2001, p. 183. 
 
 
QUESTION NO: 7 
 
Which of the following commands can be used to obtain the MAC address of a network 
card in Windows 2000/XP Professional?  
 
A.  IPCONFIG/RENEW 
B.  IPCONFIG/release 
C.  IPCONFIG  
D.  IPCONFIG/ALL 
 
 
Answer:  D 
 
 
QUESTION NO: 8 
 
Which of the following should be done for Windows XP to remain updated with current 
patches and service packs? (Select TWO). 
 
A.  Purchase and install the newest version of Windows XP.  
B.  Run Windows Update regularly. 
C.  Search the Internet and download any updates found.  
D.  Turn on and configure Automatic Updates. 
E.  use Add/Remove Windows Components to update Windows regularly. 
 
Answer:  B, D 
 
 
QUESTION NO: 9 
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What do you call the part of a CD-ROM drive's head assembly that moves across the disk 
to read it? 
 
A.  ReadyWrite Actuator.  
B.  The Mechanical Frame.  
C.  The Head Actuator.  
D.  The Disk Spindle. 
 
Answer:  C 
Explanation: The head actuator is the device that physically positions the read/write 
heads over the correct track on the surface of the disk. It is called the same for CD-
ROMs, hard drives and floppy disks. 
 
 
QUESTION NO: 10 
 
A technician updates a malfunctioning PCI card with a driver from the manufacturers 
web site, and the PCI card still does not work. Which of the following would be the 
BEST step for the technician to take next? 
 
A.  Change the latency settings in BIOS. 
B.  Install an AGP card. 
C.  Replace the PCI card. 
D.  Find another driver from a different manufacturers site. 
 
Answer:  C 
 
 
QUESTION NO: 11 
 
Which of the following should be adjusted to provide maximum battery longevity in a 
PDA? 
 
 A.  Touch screen sensitivity  
B.  irDA transfer rate  
C.  SD card bus speed  
D.  Screen backlight 
 
Answer:  D 
 
 
QUESTION NO: 12 
 
The new Certkiller .com trainee technician wants to know which of the following has a 
transfer rate of 40 MBps and a maximum cable length of 12 meters. How will you reply? 
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A.  SCSI-2  
B.  Ultra 2 SCSI  
C.  Ultra Wide SCSI  
D.  Fast SCSI  
E.  Ultra SCSI  
F.  Fast Wide SCSI 
 
Answer:  B 
Explanation: Ultra2 SCSI (8-bit) is capable of 40MB/s transfers, with a maximum cable 
length of 12 meters (39 feet), also used the same connectors as Fast-10. 
 
Incorrect Answers: 
* SCSI 2 has a transfer rate of 5Mbps and a maximum cable length of 6 meters 
*  Ultra Wide SCSI has a transfer rate of 40Mbps and a maximum cable length of 1.5 
meters 
*  Fast SCSI has a transfer rate of 10Mbps and a maximum cable length of 3 meters 
*  Ultra SCSI has a transfer rate of 20Mbps and a maximum cable length of 3 meters 
*  Fast Wide SCSI has a transfer rate of 20Mbps and a maximum cable length of 1.5 
meters 
 
Reference: 
James G. Jones and Craig Landes, A+ Exam Cram 2 (2nd Edition), QUE Publishing, 
Indianapolis, 2003, p. 327. 
 
 
QUESTION NO: 13 
 
Which of the following formats is a read-only disc that stores interactive media, data, 
audio, and video?  
 
A.  DVD-ROM  
B.  DVD-RW  
C.  CD-RW 
D.  dvd-ram 
 
Answer:  A 
 
 
QUESTION NO: 14 
 
Which of the following would be the BEST choice for data backup storage? 
 
A.  locked closet with limited access 
B.  portable locking container 
C.  secure offsite facility 
D.  locked filing cabinet in the server room 
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Answer:  C 
 
 
QUESTION NO: 15 
 
Identify the form factor of the following motherboard.  
 

 
 
A.  BTX  
B.  at 
C.  NLX  
D.  ATX 
 
Answer:  D 
 
 
 
QUESTION NO: 16 
 
Which of the following is the most secure type of file system?  
 
A.  NTFS  
B.  FAT16  
C.  FAT32 
D.  cdfs 
 
Answer:  A 
Explanation: Windows XP can handle both NTFS and FAT32, but FAT32 is only 
recommended for dual boot environments. 
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QUESTION NO: 17 
 
Which of the following computer configurations meets the minimum hardware 
requirements for installing Windows XP? 
 
A.  AMD 133Mhz Overdrive, 64MB ram, 1.0GB of free space, and VGA with monitor 
capable of 800 x 600 resolution. 
B.  233Mhz Intel Celeron Processor, 64MB ram, 1.0GB of free space, and VGA with 
monitor capable of 800 x 600 resolution. 
C.  166Mhz Intel Pentium, 128MB ram, 2.0GB of free space, and SVGA with monitor 
capable of 800x600 resolution. 
D.  233Mhz Intel Pentium II processor, 64MB ram, 1.5GB of free space, and SVGA with 
monitor capable of 800 x 600 resolution. 
 
Answer:  D 
 
 
QUESTION NO: 18 
 
Which of the following BEST describes the difference between the "baby" AT and ATX 
motherboards? 
 
A.  The "baby" AT motherboard allows for the installation of more than two full-length 
expansion cards whereas the ATX motherboard allows for only one or two. 
B.  The processor, memory, and expansion slots are all in line with each other on a 
"baby" 
AT motherboard, whereas the ATX motherboard has the processor and memory slots at 
right angles to the expansion cards. 
C.  The ATX motherboard allows for the installation of more than two full-length 
expansion cards, whereas the "baby" AT allows for only one or two. 
D.  The "baby" AT motherboard has a 20-pin power connector while the ATX has a 
12-pin power connector. 
 
Answer:  B, C 
Explanation: On the AT motherboards the processor, memory, and expansion slots are all 
in line with each other. Because the processor and memory were in line with the 
expansion slots, only one or two full-length cards could be used. Also, the processor was 
far from the power supply’s cooling fan and would therefore tend to overheat unless a 
heat sink or processor fan was directly attached to it. To overcome the limitations of the 
“baby” AT design, the ATX motherboard was designed. The ATX has the processor and 
memory slots at right angles to the expansion cards. This puts the processor and memory 
in line with the fan output of the power supply, allowing the processor to run cooler. And, 
because those components are not in line with the expansion cards, you can install full-
length expansion cards in an ATX motherboard machine. 
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Incorrect Answers: 
* Because the processor and memory were in line with the expansion slots, only one 
or two full-length cards could be used. Also, the processor was far from the power 
supply’s cooling fan and would therefore tend to overheat unless a heat sink or processor 
fan was directly attached to it. 
* The ATX motherboard has a 20-pin power connector that accepts a single power 
connector while the AT motherboard has a 12-pin power connector for the P8 and P9 
connectors. 
 
Reference: 
David Groth and Dan Newland, A+ Complete Study Guide (2nd Edition), Sybex, 
Alameda, CA, 2001, p. 61 
 
QUESTION NO: 19 
 
Two new network switches are connected but connections between them are not working. 
On the cable connecting the switches there are no lights on one side of the connection. 
Which of the following is MOST likely the cause of the problem? 
 
A.   Incompatible network protocols. 
B.   One of the switches is defective. 
C.   The connection cable is faulty. 
D.   One switch is too busy to connect to the other. 
 
Answer:  C 
 
 
QUESTION NO: 20 
 
Which of the following paths should be taken to back up the key when removing old 
registry keys in Registry Editor?  
 
A.  Key > File > Backup  
B.  Key > Tools > Backup  
C.  Key > File > Export  
D.  Key > Tools > Export 
 
Answer:  C 
 
 
QUESTION NO: 21 
 
What is clock speed of the AGPx8 expansion slot?  
 
A.  66 MHz  
B.  133 MHz  
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C.  266 MHz  
D.  533 MHz 
 
Answer:  D 
Explanation: The AGPx8 has a clock speed of 533 MHz and has a transfer rate of about 
2.1GB/s. 
 
Incorrect Answers: 
* The original specification for AGP (AGPx1) has a clock speed of 66 MHz. 
* AGPx2 has a clock speed of 133 MHz.  
*   AGPx4 has a clock speed of 266 MHz. 
 
Reference: 
James G. Jones and Craig Landes, A+ Exam Cram 2 (2nd Edition), QUE Publishing, 
Indianapolis, 2003, p. 236. 
 
 
QUESTION NO: 22 
 
Which of the following BEST describes the MAC address? 
 
A.  The static address assigned to a network interface card (NIC). 
B.  The DHCP address assigned to a NIC. 
C.  The physical address of a NIC. 
D.  The address assigned to the motherboard. 
 
Answer:  C 
 
 
QUESTION NO: 23 
 
A user has purchased a new 60GB hard drive. Which of the following would be the 
MOST secure file system to install on the hard drive?  
 
A.  NTFS  
B.  cdfs 
C.  FAT32  
D.  FAT16 
 
Answer:  A 
 
 
QUESTION NO: 24 HOTSPOT 
 
Where on the following exhibit would you insert Random Access Memory (RAM)? 
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Hot spot question. Click on the correct location or locations in the exhibit. 
 
Answer:  

 
 
 
QUESTION NO: 25 
 
he concentric area on a disc that completes one circumference of the disk is known as a:  
 
A.  track.  
B.  cluster.  
C.  sector.  
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D.  cylinder. 
 
Answer:  A 
 
 
 
QUESTION NO: 26 
 
When a user would like to access a file server with Universal Name Convention (UNC), 
which of the following information is needed? 
 
A.  hostname and path name 
B.  HTTP server address on Address Bar 
C.  SMTP server address 
D.  DHCP server information 
 
Answer:  A 
 
 
QUESTION NO: 27 
 
Which of the following components on the motherboard usually house the IDE 
connectors? 
 
A.  PCI bus.  
B.  North Bridge.  
C.  ISA bus.  
D.  South Bridge. 
 
Answer:  D 
Explanation: The South Bridge is generally used for slower devices such as USB ports, 
IDE drives, and ISA slots. 
 
Incorrect Answers: 
* The PCI bus is a sort of bridge between the processor and ISA bus. 
*  The North Bridge is generally used for high-speed interface cards, such as video 
accelerators, Synchronous RAM (SRAM), and memory. 
* The ISA bus does not house the IDE connectors. 
 
Reference: 
James G. Jones and Craig Landes, A+ Exam Cram 2 (2nd Edition), QUE Publishing, 
Indianapolis, 2003, p. 80. 
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QUESTION NO: 28 
 
Which of the following network cabling standards is LEAST susceptible to 
electromagnetic interference (EMI)?  
 
A.  fiberoptic  
B.  CAT5/5e  
C.  CAT6  
D.  CAT3 
 
Answer:  A 
Explanation: Fiber optic cable is immune to EMI. 
 
Incorrect Answers: 
* Both STP and UTP are very susceptible to EMI. 
* Coaxial cable is also susceptible to EMI, but not to the same extent as STP and 
UTP. 
 
References: 
David Groth and Dan Newland, A+ Complete Study Guide (2nd Edition), Sybex, 
Alameda CA, 2002, pp. 325,327. 
David Groth and Toby Skandier, Network+ Study Guide (4th Edition), Sybex, Alameda 
CA, 2005, pp. 19-20, 25-27. 
 
QUESTION NO: 29 
 
Which of the following modes allows a users work to be automatically saved to the hard 
drive and pause the session?  
 
A.  standby  
B.  Suspend  
C.  Shut Down  
D.  Hibernate 
 
Answer:  D 
 
 
QUESTION NO: 30 HOTSPOT 
 
Where on the following exhibit would you insert Central Processing Unit (CPU)? 
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Hot spot question. Click on the correct location or locations in the exhibit. 
 
Answer:  
 

 
 
 

 


